CHAPTER 3

Creating Views

One of the strongest points of the Autodesk® Revit® Architecture platform
is that it is one single model. This single model, however, has to be broken
down into a tangible format that allows the user to navigate through a
project. Chapter 1, “The Autodesk Revit World,” and Chapter 2, “Creating a
Model,” featured the Project Browser (which is included in this chapter as
well), but what is the Project Browser managing? Well, it’s simply managing
views of the model. The browser also handles sheets, families, groups, links,
and assemblies, but you’ll use it to open and work with the properties of
views more than anything else.

Here’s an example: in the Project Browser, under Floor Plans, you'll
usually see Level 1. This is a view of the model that just so happens to be
a floor plan. Under Elevations (Building Elevation), you’ll see East, North,
South, and West elevations. These are exactly the same as the floor plans in
the sense that they’re just views of the model.

This chapter covers the following topics:

Creating levels

Creating and modifying building sections
Adding wall sections

Creating detail sections

Creating callouts

Creating and modifying a camera view

Creating an elevation

Creating Levels

This chapter focuses on the creation of views and their relationship to the
model. You'll start with possibly the most important function in Revit:



106

Chapter 3 « Creating Views

creating levels. The power of Revit comes with the single-model concept. By
adding levels to a model, you also add floor plans. This two-way interaction is
what makes Revit the BIM choice for many users.

As you wander through the floor plans in the Project Browser, you'll see
Level 1 and Level 2. Not every job you'll work on will have only a Level 1 and
a Level 2. Your task in this section is to create new levels that are appended to
floor plans.

To follow along, open the model you’ve been working on, or go to www. sybex
.com/go/revit2017ner and browse to the Chapter 3 folder. Open the file called
NER-03.rvt. If you want, you can use an actual project you're working on.
You'll just have to replace any names and specific dimensions with ones that are
applicable to your project. Perform these steps:

1. In the Project Browser, double-click the South elevation. It’s located
under Elevations (Building Elevation), as shown in Figure 3.1.
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FIGURE 3.1: Findingan elevation in the Project Browser

Notice that at the right side of the building there are two symbols
with a datum at the end. These are elevation markers. Unfortunately,
right now they’re somewhat obscured by the exterior wall. Zoom into
this area, as shown in Figure 3.2.
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FIGURE 3.2: Whendealing with levels, it's a good idea to zoom in close so you
can manipulate them.

,r T I P Asyou progress through the next few steps, if you don’t see what is shown in
}’ the next two figures, try zooming in more and repeating the instructions.

2. Pick (left-click) Level 1. Note that you get several blue icons and a lock.
Where the actual level line intersects the datum bubble, there is
a hollow blue circle (grip), as shown in Figure 3.3, except that your
view is slightly obscured by the wall. Move the bubble so you can see
the grip clearly.

[~ Level 2
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FIGURE 3.3: Picking the grip to drag the level out of the way
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If you hover over

any item in Revit
Architecture and pause
fora second, you'll see
a tooltip. This will help
you verify that you're
selecting the correct
item.
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3. Left-click (pick) the grip, and hold the pick button on the mouse. You
can now drag the bubble to the right.

4. When you get to a point where the level marker is outside the
building, pick a spot to place the bubble and the annotation.

5. Press Esc.

Now that the levels are physically in a position where you can work on them,
you can start building on them.

Adding Levels

Adding an entirely new level in Revit Architecture is quite simple. However, you need
to adhere to certain procedures in order to ensure that you add the levels correctly.

When you use the Level feature in Revit, you should follow two procedures. The
first is to look at the Options bar after you start the command. The second is to
click the Modify button or press Esc when you've finished. It’s easy to get confused
as to how Revit wants you to proceed with adding a level, and it’s also easy to create
multiple levels inadvertently. Remember, in Revit you're always in a command.

To add a level, follow these steps:

1. On the Datum panel of the Architecture tab, click the Level button,
as shown in Figure 3.4.

IE & Area + %ﬂl gIE ;];-Wa\l- @ @ ) Show
p Vertical gﬁ 3

Ref Pl

Tag By Shaft set 47 Ref Plane
Room @ Tag Area ~ Face f Dormer

Room & Area « Opening Datum Work Plane

FIGURE 3.4: Addinga level from the Datum panel on the Architecture tab

2. On the Draw panel on the Modify | Place Level tab, you see that you
can either draw a line or pick a line, as shown in Figure 3.5. Make
sure Pick Lines is selected.
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FIGURE 3.5: Choosingthe options for the Level command
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3. On the Options bar, make sure the Make Plan View option is selected.

4. At the end of the Options bar is the Offset field. Type 10" (3000 mm),
and press Enter. Basically the approach here is to pick Level 2 and
create a new level that is offset 10’ (3000 mm) above (see Figure 3.5).

5. With the options set, hover your cursor over Level 2.

When you come into contact with Level 2, a blue dotted line
appears. If you move your cursor slightly above the Level 2 line, the
blue alignment line appears above Level 2. If you inch your cursor
slightly below Level 2, the blue alignment line appears below Level 2.

6. When you see the blue line appear above Level 2, pick the Level 2
line, as shown in Figure 3.6.

Level 2
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FIGURE 3.6: Waiting for the alignment to appear

T I P Youmay notice that speeding through the commands as you may have done in
Autodesk® AutoCAD® isn’t helping you at all in Revit. In Revit, you may need to slow down
a bit and let Revit “do its thing.” After you get the hang of the Revit behavior, you can
speed up again.

You should now have a Level 3 at 20" (6000 mm), as shown in
Figure 3.7.

30

Level 2
10'-0"

FIGURE 3.7: Thecompleted Level 3. Remember, you're still in the Level
command until you tell Revit to stop.
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W A RN I N G Justhbecause you've created a new level, this doesn’t tell Revit
to shut down the command. Notice that the Options bar is still active and the Pick Lines
icon still has the focus. If you start clicking around in the view area, you'll create levels.
Every time you pick a point on the screen, a new level will appear. Also, Revit doesn't care
if you have a level on top of another level. This situation can get ugly fast.

&

7. With the Level command still running, create Levels 4, 5, 6, and 7. Your
elevation should now look like Figure 3.8. Also, look at your Project
Browser. It shouldn’t have any levels other than Levels 1 through 7 and
Site. You also have new levels under the Ceiling Plans category.

FIGURE 3.8: Levels1through?7are complete.

8. On the Select panel of the Ribbon, click the Modify button. You've
safely terminated the Level command. (You could also press the Esc
key on your keyboard to end the command.)

Now that you have some experience adding levels, it’s time to investigate the
physical level to see how it can be manipulated and modified.

Understanding the Composition of a Level

Levels have controls that enable the user to adjust the level’s appearance. As
stated throughout the book, when you select a family, multiple items turn blue.
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The blue color indicates that these items can be modified. Also, if the level
bubbles are blue, that means there is a plan with which the level is associated.
If the bubble is black, then no plan is associated. When you select a level, a few
additional items will appear.

To investigate further, follow these steps:

1. Zoom in on Level 7.

2. Select Level 7 by picking (left-clicking) either the text or the level
line. This puts the focus on the level line. Notice that the text turns
blue. You know that any blue item can be modified (see Figure 3.9).

Level 7 &
60! _ O" ~

FIGURE 3.9: Theselected level

3. Click the blue Level 7 text field. This enables you to edit the name of
the level.

4. Type Parapet, as shown in Figure 3.10, and press Enter.

30

IFarapet
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FIGURE 3.10: Renaming the level

5. Revit asks whether you want to rename any corresponding views.
Click Yes (see Figure 3.11). Level 7 is now the Parapet level, as shown
in Figure 3.12.
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By renaming Would you like to rename corresponding views?
corresponding views,

you tell Revit to keep
the level and its 4 = )

corresponding view

named accordingly. FIGURE 3.11: ClickYestorename corresponding views.

Parapet
60I - Oll

FIGURE 3.12: Therenamed level

6. With the Parapet level still selected, click the 60°—0” (18000 mm)
field.

7. Type 52’ (16600 mm), and press Enter. This physically drops the level
to the true elevation.

e You now have two slightly overlapping levels. This can be fixed by
manipulating some of the controls that appear when you select the level.
Can'tyou just type

AR Press the Esc key a few times to clear any commands that may be active, and
over the dimension? In
Revit, youcan'thavean  then follow these steps:

inaccurate increment.
Ifyou type a new value )
to any increment, the exercise).

model wil c.ha"ge 2. The blue items light up. One of them is the choice to add an elbow, as
to reflect this new

ey shown in Figure 3.13. Click it, and Revit bends the level.

1. Select the Parapet level (if it isn’t still selected from the previous

30

Parapet

FIGURE 3.13: Youcanaddanelbow to the elevation marker.
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3. Now that you've added the elbow, you need to move it. Notice the blue
grip at each bend point. Pick the blue grip, as shown in Figure 3.14,
and drag the Parapet level out of the level below.

Parapet ﬂ Parapet
52' /" 52' < 0"

a’/ Q 70/
Parépot . Level6 g+
52' - 0" . 50'-0" ¥

FIGURE 3.14: Dragging the level toanew position by using the grips provided

4. The line of the level is still in the way. The two blue grips are still
available, pick and drag the horizontal line out of the way of the
Parapet text, as shown in Figure 3.15.
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FIGURE 3.15: Making the final adjustments to the level

Now that you've established the Parapet level, let’s make modifications
to Level 6. Luckily, the procedures are the same as when you made the
modifications to the Parapet level.

1. Press Esc to clear any commands.
Select Level 6.

Pick the blue text that reads Level 6.
Rename it Roof.

Press Enter.

S A~ w N

Click Yes to rename the corresponding views.
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7.

Press Esc. Your levels should look like Figure 3.16.

Parapet
52| - 0"

~ Roof
50| - Oll

FIGURE 3.16: TheRoofand Parapet levels

Making Other Level Adjustments

I need to review three more adjustments before you can move on. As you may
notice, the level lines are projected all the way to the other end of the east
building. Only level heads and level data are displayed on the right side of the
level line. You can control the other end of the level as well.

To follow along, pan over to the left side of the building, where the level lines
seem to stop, as shown in Figure 3.17.

Show Bubble |

N
*

FIGURE 3.17: Youcan click the box that appears to turn on the level information at the
other end of the building.

Then perform these steps:

1.

Select the Parapet level.

2. Pick the small blue box to the left of the level. Doing so turns on the

level information at that end of the building (see Figure 3.17).

3. Turn on the Roof-level left-end bubble as well. Use the blue adjustment

icons (elbow icons) to move the level out of the way (see Figure 3.18).

Parapet
52! - 0"

Roof
50! - Oll

FIGURE 3.18: Controlling the visibility of the levels at the other end
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With the two upper levels established, you can constrain some walls up to these
levels. Sometimes the best way to do this is to look at the model from a 3D view.

1. Click the Default 3D View icon on the Quick Access toolbar at the top
of your screen, as shown in Figure 3.19.
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FIGURE 3.19: C(licking the Default 3D View icon

2. The next step is to select all the walls you want to be extended to the
Parapet level. In this case, only the east building will go all the way
up to this level. Select the exterior and the elevator shaft walls, as
shown in Figure 3.20. (Be sure to select all the elevator shaft walls
as well.) You must hold the Ctrl key to add to the selection. The walls
turn blue when they’re selected. You can also hover over one of the
walls and press the Tab key. Once the walls are highlighted, pick a
wall. All of the walls will be selected.

FIGURE 3.20: Selecting the walls that extend to the Parapet level
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3. In the Properties dialog, under the Constraints category, change
Top Constraint to Up To Level: Parapet, as shown in Figure 3.21.
Click Apply or move your cursor into the drawing window to set the
property change. The walls should now extend to the Parapet level, as
shown in Figure 3.22.
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Top Constraint Unconnected j
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FIGURE 3.21: Settingthe top constraint to Up To Level: Parapet

FIGURE 3.22: Thewallson the eastside of the building are now constrained
to the Parapet level.
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4. In the Project Browser, double-click the South elevation under
Elevations (Building Elevation).

5. Start the Level command again.

6. Offset Level 4 up 4’ (1200 mm). Remember, you're in the Level
command. You must choose Pick Lines on the Draw panel. Also, you
must specify an Offset value of 4—0” (1200 mm) on the Options bar.

7. Offset another level up from the fourth level, 2-0” (600 mm), and
then press Esc a couple times to terminate the command.

8. Rename the 4-0” (1200 mm) offset level West Parapet. Click Yes to
rename corresponding views.

9. Rename the 2'—0” (600 mm) offset West Roof (see Figure 3.23), and
click Yes to rename corresponding views. You'll have to add elbows to
the levels to see the names and elevations.

Level 5
~ .o P
est Parapet S
34l - Oll

West Roof
32l - Oll

Level 4 S
- 30l - Oll

FIGURE 3.23: Addingtwo new levels for the west side of the building

See? Adding levels isn’t all that hard. You just need to know how Revit wants
you to do it. Now that you've added some levels, you can go back and configure
how they’re displayed.

1. For the two new levels, uncheck the Show Bubble check box to the
right of the level lines by clicking the Hide Bubble check box.

2. Display the bubbles to the left side of the level line by selecting the
Show Bubble check box. The level should now look like Figure 3.24
(you have to add those elbows again).
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Parapet
652-0'\ o
wﬂf, - - _ ===
50'- 0"

West Parapel
e 42 - 0" ™ — B
GB West Roof _ —_ =
40' - 0"

FIGURE 3.24: Usingthedisplay bubble toggles to switch the display to the
appropriate side of the building

. Staying focused on the left side of the building, select the West

Parapet level.

. Notice that some blue icons still appear. One of those icons reads 3D.

. Pick (left-click) the 3D icon. It now reads 2D. The larger, hollow blue

grip turns into a smaller, solid grip. You can now drag the level end
without dragging the rest along with it. The 2D function also ensures
that this modification doesn’t affect other views (see Figure 3.25 and
Figure 3.26).
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FIGURE 3.25: Turnoffthe 3D extents so you can drag the level end freely and
without disturbing any other view.
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10.
11.

@ West Parapet

Modify the level by dragging its view specific extent

]

FIGURE 3.26: Thelittle blue grip enables you to drag the entire level.

Repeat the procedure for the West Roof level. Now both of the level
ends are set for 2D extents. The blank ends at the right side are still
set to 3D extents.

Select the West Parapet level, activating the grips.

Pick the blue grip, and drag the end to the left side of the building,
approximately to the location shown in Figure 3.27. Notice that the
two 2D lines are locked to one another.

West Parapet

@Mtinof___________
32'-0

Level 2
B — - — e

Level 1
0-0

FIGURE 3.27: Youcandragthe 2D level ends wherever you want them.

Drag the West Roof level to the left as well.
Turn on the left side for Levels 1 and 2.

Switch these levels to 2D, and drag them to align with the West
Parapet and West Roof levels, as shown in Figure 3.27. (If you can’t
pick a level, hover over it with your cursor and press the Tab key.
When the level highlights, pick it.)
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12. Add another level 2’ (600 mm) above Level 3, and call it Corridor
Parapet. Click Yes to rename corresponding views.

13. Turn on the level information on the left side.

14. Turn off the level information on the right side.

0

W A RN I N G Onalmostevery project, you'll have to adjust a level’s display
in different views. Keep in mind that if the 3D button is left on, moving the level in the
current view will also move it in other views—sometimes for the better and sometimes
for the worse. Switching to 2D can eliminate aggravation.

15. On the left side, turn on the 2D extents.

16. Drag the left side of the line to an area approximately as shown in
Figure 3.28.

West Parapet

@ WestRoot " T T
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FIGURE 3.28: Allthelevelsareinplace for now.

Let’s move these walls to their proper levels. Again, in this case it may be a
little easier to go to a 3D view so you can get a good perspective on the results of
constraining the tops of the walls. Perform the following steps:

1. Click the Default 3D icon on the Quick Access toolbar.

2. Inthe 3D view, select the west side of the building, excluding the
corridor and the three walls to the south, as shown in Figure 3.29. You
should have seven walls selected. To check this, look in the lower-right
corner of the Revit window. You see a filter icon with the number 7 next
to it. (You need to press and hold the Ctrl key for multiple selections.)
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FIGURE 3.29: Selecting the west part of the building

. In the Properties dialog, set Top Constraint to Up To Level: West
Parapet. Click Apply or move your cursor into the view window.

In the 3D view, your walls should grow to meet the new
constraints.

. Press Esc.

. Select the corridor walls as well as the three south walls whose
tops remain unconstrained. (You may need to rotate the view to see
everything.)

. In the Constraints category of the Properties dialog, set Top
Constraint to Up To Level: Corridor Parapet (see Figure 3.30).

FIGURE 3.30: Thefinal wallsare constrained to the Corridor Parapet level.
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7. Go back to the South elevation. Set the top constraints of the selected
walls to Corridor Parapet, as shown in Figure 3.31.

FIGURE 3.31: Thefinal look of the building

8. Save the model.

Creating and Modifying Building Sections

As your model starts to develop, you’ll begin to see areas that need further
attention. (Certainly the area where the corridor hits the west building needs to
be fixed.) This brings us to a good point. Sections in Revit Architecture, when
placed into the model, not only help you build a set of construction documents
but also help you work physically on the model. For example, you need to fix the
east wall of the west wing. However, you don’t have any good views established
that focus directly on this area. This is the perfect place to add a section!

Adding a Building Section
To add a section and some important wall-modify commands, follow these steps:

1. Go to Level 1 Floor Plan, and zoom in on the area where the corridor
meets the west wing of the building.

2. On the Create panel of the View tab, select Section, as shown in
Figure 3.32.
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FIGURE 3.32: TheSectioncommand is found on the Create panel of the View tab.
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3. A section takes two picks to place into the model. You must first pick
the point for the head; then you pick a point for the tail. To place the
section as shown in Figure 3.33, first pick a point above the corridor
and to the right of the vertical wall.

Y

2
3=

FIGURE 3.33: Placingthe sectioninto the model

4. After you pick the first point, move your cursor straight down the
view. When you're positioned directly below the bottom corridor wall,
pick the second point (see Figure 3.33). If the section is facing the
wrong way, that’s fine. You'll fix that in a moment.

5. With the section placed, it looks like you need to flip it to face
the wall you intended to modify. A few blue icons appear. You're
interested in the icon that looks like two arrows. This is a flip grip.
It’s the same thing you saw in the doors and windows (see
Figure 3.34).
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o

FIGURE 3.34: Afteryouselectthesection, you'll see the flip grip.

6. When you see the flip grip, pick it. It flips the section into the correct
direction.

W A RN I NG |maybejumping ahead, but here’s a word of caution: if you cut
a section in Revit Architecture and then place detail components and draft over the top of
that section, you're stuck. Don’t flip or move the section after you've drafted over the top
of it. The results will be bad. The walls will move, but your line work won't, leaving you
with a mess.

&

With the section flipped in the correct direction, a dashed line
forms a box around part of the model, as shown in Figure 3.35. This
forms the view extents of the section. Anything outside this box
won’t be shown.

7. The vertical dashed line (to the left) has a move arrow. Pick the move
arrow, and drag the crop region into the area shown in Figure 3.35.

K N O T E Ifthesectionisn’t selected, you need to select it. You must pick the line of
3 the section, not the bubble. When you pick the line, the section is selected.

8. With the section still selected, notice the small, blue break icon in the
middle of the section (see Figure 3.36). Pick the break line (it’s called
the Gaps In Segments icon). The section is now broken, and you have
grips controlling the ends of the break lines (see Figure 3.36).
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FIGURE 3.35: Youcancontrol how deep into the building you want the
section to appear.
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FIGURE 3.36: Addingagapin the section. You can move your grips to be the
same as the figure.
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9. At each end of the section is a blue icon that resembles a recycle symbol.
This controls what the section head displays. By selecting this icon, you
can choose to have a section head, a tail, or nothing. At the tail of the
section, cycle through until you get a section head (see Figure 3.37).

o
| Cycle Section Tail i

FIGURE 3.37: Cyclingthrough the display choices

With the section cut, it’s time to open the view you've created. In the Project Browser,
you now see a new category called Sections (Building Section). In this category is a
view called Section 1. When you cut the section, you added a view to the project. This
view carries its own properties and can be drafted over (see Figure 3.38).
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FIGURE 3.38: TheProject Browser with the new section
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T 1 P Beorganized. Using BIM doesn’t negate the need for basic organization. The
first thing you should do when creating a section (or any new view, for that matter) is give
itaname. If you don’t and you leave your sections as Section 1, Section 2, Section 3, and so
on, you'll find yourself wasting a lot of time looking for the right view.

At this point, you need to name the section and open the view. You can also
fix the gap in the wall while you're at it. Perform the following steps:

1. In the Project Browser, right-click Section 1.

2. Choose Rename from the context menu (see Figure 3.39).

COTOr STTETTTE T TIEIE T X
Properties help Open
—_— Close
i i e i | Find Referring Views..
Corridor Parapet e — :
Level 1 ake Workset Editable
Level 2 Apply Template Properties...
Level 3 Create View Template From View...
Level 4 . )
Level 8 Duplicate View 2
Parapet Convert to independent view
Roof Apply Dependent Views...
West Parapet Save to Project as Image.
West Roof Delete
& 3D Views Copy to Clipboard
- Elevations (Building El Rename...
East Select All Inslanc%s ’
North
South v Properties
West Save to New File.
= Sections (Building Seci
ey, Search-

FIGURE 3.39: Youcanrename the view by right-clicking in the Project
Browser.

3. Change the name of Section 1 to West Corridor Section.

4. Click OK.

5. Double-click the West Corridor Section in the Project Browser. Doing
so opens the section. You can see the two corridor walls and the west

wing beyond.

6. Chances are that the section looks great, but no levels are displayed.
If you can’t see your levels, open the south elevation.

7. Select a window around the west levels, as shown in Figure 3.40.

8. With the levels selected, place your pointer directly on top of one of
the levels, and right-click.

127
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FIGURE 3.40: Bychoosing Maximize 3D Extents, you can control the visibility
of the levels in other views.

9. Select Maximize 3D Extents, as shown in Figure 3.40.

10. Go back to the West Corridor Section to clean up the levels so they’re
to the right of the building and the Parapet level isn’t overlapping the
level below (see Figure 3.41).

N O T E  Notice that when you're adjusting the levels in the section, the 2D icon

% appears. This means any adjustments made here won't affect any other views. In a
sectional view, Revit automatically makes the levels 2D. In an elevation view, however,
Revit makes the levels 3D. If you want to make adjustments in an elevation, it's a good
idea to turn these into 2D extents.



Creating and Modifying Building Sections 129

O Coarse
= Medium
1o BT %% 8D

FIGURE 3.41: OntheView Control bar, set Fine as the detail level.

11. On the View Control bar, select Fine for the detail level, as shown <4 |
in Figure 3.41. (Making adjustments like this to a view will become

In Revit Architecture,
second nature to you soon.)

you can also double-
click the annotation
that refers to the view
you want to open. For

Cutting a section is immensely helpful in terms of viewing the model from
any perspective you want. To go even further, when you cut a section, you can

also work on your model by modifying any item in the section. example, if you want to
open the West Corridor
. TPr oo . . . Section and you're in
Making Building Modifications in a Section a plan,allyou have to
Now that you've had a good look at this side of the west wing, it’s obvious do s double-click the

. . . . section bubble, and
that this wall needs to be repaired. In Revit Architecture, you can make a the view will open. If

modification to a building in any view. This is good and bad. Just remember that  you'rein the section
everything you do has a downstream effect on the entire model. and you want to go
The following procedure will guide you through making a modification to a back to a floor plan,

, oo . . you can double-click
wall’s profile while in a section view: 2 datum bubble, and

1. In the Project Browser, find the West Corridor Section and open it Revit will open that
by double-clicking the name West Corridor Section (if it isn’t open view:
already).

2. In this section, select the east wall of the west wing, as shown in
Figure 3.42.

3. After you select the wall, click the Edit Profile button in the Modify |
Walls tab.



130

After you select a wall,
you can access options
to modify that wall.
Edit Profile is one of
those options.
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Modify View | Measure | Create od Modify Wall Wall Sweep

FIGURE 3.42: Selectingthe wall to be modified and clicking Edit Profile

You're presented with a magenta outline of the wall. This magenta
outline can be modified to alter the wall’s profile. On the Ribbon,
Edit Profile has been added to the title of the Modify | Walls tab. This
enables you to focus on the modification at hand.

. On the Draw panel of the Modify | Walls > Edit Profile tab, select the

Line button, as shown in Figure 3.43.
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FIGURE 3.43: Addinglinesto alter the wall’s profile

5. With the Line command running, move your pointer to the vertical

magenta line on the right where it intersects the Corridor Parapet
level, as shown in Figure 3.44.

6. When you see that you're snapped and aligned with the magenta line

and the Corridor Parapet level, pick this point. Your line starts.
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FIGURE 3.44: Revitalignsyour cursor to levels, enabling you to sketch a new
profile accurately.

. Draw the line to the right until you intersect with the centerline of
the corridor wall, as shown in Figure 3.45.

Endpoint and Horizontal |

&
26 -9 1116 ndpoint and Horizontal

FIGURE 3.45: Drawing theline from the left wall to the right

. When you see the snap icon appear, pick this point (see Figure 3.45).

. Draw the line straight up the wall to the top. Make sure you don’t
snap to the top of the parapet cap. The point you want is to the top of
the brick, as shown in Figure 3.46. (All you're doing here is sketching
the profile of the wall.)
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FIGURE 3.46: Drawinganotherline from Level 3 to the bottom of the Corridor
Parapet level

10. Continue drawing the line from right to left, across the top of the wall.
Snap to the endpoint of the wall to the left, as shown in Figure 3.47.

FIGURE 3.47: Drawing the line across the top

11. Press the Esc key, or click the Modify button on the Select panel.

12. Pick the vertical line to the left that goes from the bottom of the wall
to the top.

13. Pick the top blue grip, and stretch the line down to Level 3.
You now have a closed loop, as shown in Figure 3.48.

‘") W A RNI NG Ifyoudon’t have a perfectly closed, continuous loop with your

\ magenta lines, Revit won't allow you to proceed to finish altering the profile of this wall.
Make sure you have no gaps, overlaps, or extra line segments aside from the six lines you
need to form the wall’s outline.
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FIGURE 3.48: Closing the wall by using grips to stretch the line

On the Wall panel of the Modify | Walls > Edit Profile tab, click
Finish Edit Mode, as shown in Figure 3.49. Your finished wall profile
should look like Figure 3.50.

[GE Modity [ Walls > Edit Profie. |G|
EIRREF—2 X /2060 -
n | FOCON,
s 5%

View | Measure |  Create Mode | Draw

FIGURE 3.49: C(lickingFinish Edit Mode

FIGURE 3.50: Thefinished wall profile
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There is one thing left to do before you leave this section: select the two-hour
fire-rated partition wall that is constrained only to Level 2. Now that you've
opened up this area, the wall can go up to Level 3. To constrain the top of this
wall to Corridor Parapet, follow these steps:

1. Select the internal (white) wall with the arched opening, as shown
previously in Figure 3.50.

2. In the Properties dialog, change Top Constraint to Up To Level:
Corridor Parapet, as shown in Figure 3.51.

FIGURE 3.51: Choosing the properties to change a wall’s constraints is
becoming old hat!

3. The partition wall now meets the brick exterior wall.
4. In the Project Browser, double-click Level 3 Floor Plan view.

5. Change the detail level to Fine. (Remember, this option is on the
View Control bar at the bottom of the screen.)

6. On the View tab, click the Section button.

7. Place a section as shown in Figure 3.52. Make sure the extents are
similar to the figure.

8. In the Project Browser, right-click the new section and rename it
West Wing South Wall Section. You'll use this section in Chapter 4,
“Working with the Autodesk Revit Tools.”

Adding entire building sections is a great way to break down the model
quickly into large segments. Another type of section, a wall section, enables you
to view smaller portions of the item being detailed.
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FIGURE 3.52: Addinganothersection to modify another wall

Adding Wall Sections

A wall section is basically the same as a building section. The only difference is
that when you place a wall section, Revit holds the extents to a much smaller
area. When you add a building section, Revit wants to extend to the farthest
geometry. That being said, a wall section is usually placed to show only the item
being cut but not the geometry beyond.

To place a wall section, follow this procedure:

1. Double-click Level 1 in the Project Browser.

2. On the View tab, pick the Section button (the same one you picked
for the building section).

3. In the Properties dialog box, select Wall Section, as shown in
Figure 3.53.

‘ W A RN I NG Ifyou'redirected to go to a specific floor plan and your view

\ , looks nothing like the one shown in the book, you need to make sure you aren’t in a ceiling
plan. Notice in the Project Browser that you have floor plans and ceiling plans. The two
are quite different. Make sure you're in a floor plan.
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FIGURE 3.53: Changing the type of section from Building Section to Wall
Section

4. Add the section through the corridor wall that was modified in the
previous section of this chapter, as shown in Figure 3.54.

FIGURE 3.54: Thewallsectionin the plan
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5. Right-click the new section in the Project Browser. It’s in a category
called Sections (Wall Section).

6. Select Rename.
7. Call the new section Corridor Entry Section. Click OK.
8. Open the Corridor Entry Section.
9. Change the scale to 1/2” = 1’-0” (1:20 mm).
10. Change the detail level to Fine. Your section should look like
Figure 3.55.
<

FIGURE 3.55: Thefinished wall section

11. Save the model.

You're narrowing down the types of sections you can use, and it’s time to
venture into a specific type of section that can enable you to create a plan-section
detail.
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Creating Detail Sections

There is a third type of section we need to discuss: the detail section. Revit refers
to this type of section as a defail view, so that’s how we’ll start addressing it.
To add a detail section, perform the following steps:

1. Open the view called Corridor Entry Section (if you don’t have it open
already).

2. On the View tab, select Section (yes, the same section you've been
using all along).

3. In the Properties dialog box, select Detail View: Detail.

4. Place a section horizontally below the head of the opening, as shown in
Figure 3.56. Make sure the section is flipped so it’s looking downward.
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u Ko -8 B Dl Dlg = =
Fat- - 5 o = 0808 - .
Modity IQI . o O = - ‘/i . o
T Y Pon- KA VT Q R I
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FIGURE 3.56: C(reatinga plansection detail

5. In the Project Browser is a new category called Detail Views (Detail).
Expand the tree, and you see your new detail. It’s usually called
Detail 0, depending on the number of details that have been added to
the model previously.
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6. Right-click Detail 0, and select Rename.

7. Rename the detail Plan Detail at Corridor Opening, and click OK.
8. Open the Plan Detail at Corridor Opening view.

9. Change the scale to 1’ 1/2” = 1’-0” (1:5 mm).

With the detail open, you may be able to see only two dashed lines. This is
because the crop region needs to be expanded, as explained in the next section.

Using Crop Regions

The border that surrounds the detail is called a crop region. It dictates the
extents of the specific view you're in. You can adjust this crop region and use it
to your advantage. To learn how to make adjustments to the crop region, follow
these steps:

1. Select the window surrounding the detail, as shown in Figure 3.57.

r“ H1

F ‘= U ' p,

FIGURE 3.57: Stretchingthe crop region to view the detail

2. You see four blue dot grips at the midpoint of each line. Pick the top
grips, and stretch the top region up until you can see the opening
jamb (see Figure 3.57).

3. Repeat the process for the bottom so you can see the entire opening.

4. With the crop region still selected, notice the break icons similar to
the make-elbow icons in the level markers. Pick the break icon, as
shown in Figure 3.58. Slice part of the section away, resulting in two
separate cropped regions.
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Horizontal view break

i

FIGURE 3.58: Splitting the section

5. Within the cropped regions are blue move icons. If you don’t see blue
icons, as shown in Figure 3.59, you need to select the crop region again.

6. Slide the sections closer together by clicking the top icon and moving
the section down. (Be careful; if you slide them too close together,
you’ll get a warning telling you that the two regions are being joined
back to one.)

7. Save the model.

You now have nice control over how the details are shown. Let’s go back and
learn how to make the section marker more aesthetically pleasing.

Splitting a Section Segment

One more section item, and then you're finished! Sometimes you need to split
(or jog) a section. You do this to show items that aren’t necessarily in line with
one another. You can accomplish this in Revit Architecture as follows:
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FIGURE 3.59: Slidingthe view regions tighter together

. Open the Level 1 floor plan.

. On the View tab, click the Section button. (You can also grab a
section from the Quick Access toolbar.)

. In the Type Selector, select Building Section.

. Pick a point above the corridor that connects to the east wing of the
building for the section head, and then pick a point well below the
bottom of the corridor, as shown in Figure 3.60.

. In the Project Browser, find the section you just made and rename it
East Corridor Section.
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FIGURE 3.60: Addinganothersection to the model

6. Select the new section marker.

7. On the Section panel of the Modify | Views tab, click the Split
Segment button.

8. Pick a point along the section line just below the corridor, as shown
in Figure 3.61.

COMPLETE

FIGURE 3.61: Jogging a section calls for splitting the segment.
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9. Move your cursor to the right. A jog appears in the section; place the
jog into the building. The section is now jogged into the building.
Press Esc twice to clear the command.

Finally! You're finished with sections. Just remember that by adding a section
to the model, not only are you preparing to build your construction documents,
but you're also enabling access to specific elements, thus allowing you to make
modifications you otherwise could not have made.

Creating Callouts

Creating an enlarged area of your model will be a task on every project you
tackle. Luckily, in Revit Architecture, not only are callouts easy to add to your
model but they also directly link to the view to which they refer. This is crucial
for project coordination. Another nice thing about callouts is that you can make
modifications to the callout view independent of the host view from which you
pull the information. The biggest change you make is the scale. Yes, your call-
out can be at a different scale from the main floor plan.

Here’s the procedure for adding callouts:

1. In the Project Browser, under Sections (Wall Section), open the
Corridor Entry Section.

2. Find the View tab on the Ribbon.
3. On the View tab, click the Callout button, as shown in Figure 3.62.

4. Pick a window around the area where the corridor firewall meets the
exterior wall with the brick facade, as shown in Figure 3.63.

5. In the Project Browser, there is a new Sections (Wall Section) item.
Its name is Callout of Corridor Entry Section—which is fine just the
way it is. Press Esc.
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5 Duplicate View
Section |Callout & Bup

Plan

View Views N Legends ~

Callout

Creates a callout in the view.

Press F1 for more help

FIGURE 3.62: TheCalloutbuttonislocated on the View tab.
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FIGURE 3.63: Thecalloutareaisdirectly related to the view it’s calling out.

6. Select the callout you just added by picking any point along the line.
A bunch of blue grips appear. These grips enable you to stretch the
shape of the callout.

7. Pick the grip that connects the callout bubble to the leader coming
from the callout window.

8. Drag the bubble to the location shown in Figure 3.64.

9. Pick the blue midpoint grip on the leader and create an elbow, as

shown in Figure 3.64.
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FIGURE 3.6 4: Adjusting callouts will be a common task.
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10.

11.
12.

13.

In the Project Browser, find Callout Of Corridor Entry Section under
the Sections (Building Section) category, and open the view. (You can
also double-click the callout bubble to open the view.)

With the section open, select the crop region, as shown in Figure 3.65.

Change the scale to 1’ 1/2” = 1'- 0” (1:5 mm).
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FIGURE 3.65: Selectingthe crop region

After you select the crop region, you see an additional region that
consists of a dotted line. This is called an annotation region, and
it gives you a gutter in which to place text outside the area that is
physically being cropped.

Type WT. This tiles the windows you have open.

The callout window is selected in the Corridor Entry Section along
with the crop region in your callout. That’s because the two objects
are one and the same (see Figure 3.66).
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The crop region and
the callout outline are
the same. If you modify
one, the other changes
accordingly.
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FIGURE 3.66: Modifythe crop region by selecting it and stretching the grip.

14. Stretch the crop region closer to the actual wall, as shown in
Figure 3.66.

15. Save the model. You'll use this detail in future chapters to get the
model ready for construction documents.

Now that you’ve created a callout for a detail, let’s go to the plan and create
some callouts there. It would be nice to have some typical lavatory callouts as
well as a typical elevator callout.

1. In the Project Browser, go to Floor Plan Level 1. (It may need to be
maximized because you tiled the windows in the previous exercise.)
Make sure it’s a floor plan, not a ceiling plan.

2. Zoom in on the area shown in Figure 3.67.
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Views : Floor Plan : Callout of Level 1]

FIGURE 3.67: (Creatingaplan callout

. On the View tab, select Callout.
. Pick a window around the lavatory, as shown in Figure 3.67.

. In the Project Browser, under the Floor Plans category is Callout Of
Level 1. Right-click Callout Of Level 1, and select Rename.

. Rename it Typical Men’s Lavatory.
. Open the Typical Men’s Lavatory view. Choose Zoom To Fit.

. The detail level is set to Coarse. Change it to Fine. Note that the
callout is placed in the Project Browser under the category where it
was created; you won’t see a “callouts” category.
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,7 T 1| P Youmay have noticed that you've been opening quite a few views. It's a good
,9 idea to close the views you don’t need open, because they could slow you down a tad. To
close views, choose Window > Close Hidden Windows.

10.
11.

12.
13.

14.

Save the model.
Open the Level 1 floor plan.

Create a callout for the women’s room below the corridor (directly
below the men’s room).

Name the new callout Typical Women’s Lavatory.

Create one more callout around the elevator shaft in the east wing, as
shown in Figure 3.68.
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FIGURE 3.68: Theplanshowing the three typical callouts

Name the new callout Typical Elevator Shaft.

The boring views are out of the way! Let’s create some perspective views of the
model. Creating these views is just as easy but requires a specific procedure in
which you’ll take advantage of the camera function.

Creating and Modifying a Camera View

The camera view is the view with which you’ll have by far the most fun. Revit
Architecture seems to lend itself naturally to this type of view.
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Taking a camera view essentially tells Revit to look at a certain area from a
perspective vantage point. Like a section or a callout, such a view may never
see the light of day in terms of going on a drawing sheet, but camera views are
perfect to see how a model is coming along from a realistic point of view.

Adding a Camera View
To create a camera view, follow these steps:
1. Go to the Level 1 floor plan.

2. On the View tab, click the drop-down arrow in the 3D View button
and select Camera, as shown in Figure 3.69. (You can also access this
on the Quick Access toolbar.)

View
@ Q ~® @ ﬁ [ Drafting View [ Schedules
L
- 5 Duplicate View ~ of: Scope Box
3D |Section Callout Plan _ Elevation | Dupll o?-‘ P
View | Views - Legends ~
¥ Create
@ Default 3D View
(
‘ Camera
.. Walkthrough| Camera
B
@ LI Creates a 3D view from the perspective of a camera placed in the
view.
Press F1 for more help

FIGURE 3.69: Addingacameraview

3. Pick a point in the main corridor of the east wing, and move your
cursor to the left—down the hallway. You want to take a perspective
view as if you were standing in the intersection of the two main
corridors, as shown in Figure 3.70.

4. The second point you pick will specify how far the camera reaches
into the building. Pick a point past the corridor doors, as shown in
Figure 3.71.

5. Unlike when you're placing a section or a callout, Revit automati-
cally opens the new 3D view. This doesn’t mean it automatically has
a useful name. In the Project Browser, you see a new view in the 3D
Views category. It’s called 3D View 1. Right-click 3D View 1, and name
it East Wing Corridor Perspective.
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FIGURE 3.70: Placing the camera view in the main corridor

FIGURE 3.71: Theperspective view down the east wing corridor
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6. On the View Control bar located at the bottom of the view, change
Visual Style to Realistic.

7. Two buttons to the right is the Shadows button. For a perspective
view, turning on shadows is OK if the view is relatively small. In this
example, go ahead and turn them on.

When the camera is in place, you may find it difficult to modify at first. You
can do quite a bit to the view, but the following section focuses on modifying
the actual camera in the plan.

Modifying the Camera

After you place the camera in the model, Revit doesn’t leave behind any evidence
that the camera is there. If you need to make adjustments or see the location
from which the view is being taken, perform the following steps:

1. Open the Level 1 floor plan.

2. In the Project Browser, right-click the East Wing Corridor
Perspective view in the 3D Views category, and select Show Camera,
as shown in Figure 3.72.
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FIGURE 3.72: Byfindingtheview in the Project Browser, you can tell Revit to
show the camera in the plan.

The camera appears in the plan temporarily so you can see it. In the view,
the camera icon is a triangle and a straight line. You can physically move the
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camera, and you can also adjust the grip on the midpoint of the triangle to
swivel and to look farther into the model. Figure 3.73 shows the perspective
view.
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FIGURE 3.73: Theperspective view

Creating an Elevation

I saved the best view—or at least, the most popular—for last. Elevations are
essential for any project. They’re so essential, in fact, that Revit provides four
of them before you place a single wall into the model. The four shapes that
represent houses that were in the model at the beginning of the book are
elevation markers, as shown in Figure 3.74. These markers are typically handy
but are most certainly now in the way. The first thing you need to do is to move
one of them out of the way. The second thing you need to do is to create a few
new ones!
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FIGURE 3.74: Theelevation markerisrightin the way!

To start manipulating elevations, follow these steps:

1. Go to the Level 1 floor plan. In the eastern part of the corridor is

an elevation. Yours may be in a slightly different location than the
book’s example, but it needs to be moved nonetheless (see
Figure 3.74).

You’re about to move the elevation marker. To do so, however,
you need to break down what an elevation marker comprises. It’s
actually two separate items: the square box is the elevation, and
the triangle is the part of the marker that activates the view, as
shown in Figure 3.75. To move this elevation marker, you must pick
a window around both items and move them together. If you don’t,
the view will stay in its original location, leaving you wondering
what is wrong with your elevation.

Views : Elevation : West

[Elevation; : Elevation : Elevation 3 ]

FIGURE 3.75: Theelevation markeris broken down into two pieces. You need
to move both together by picking a window around the entire symbol.
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2. Pick a window around the elevation marker. Make sure you aren’t
picking any other items along with it.

3. Move your mouse over the selection. Your cursor turns into a move
icon with four move arrows, as shown in Figure 3.76.
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FIGURE 3.76: Youcandragthe elevation marker when the entire item is

selected.

4. Drag the elevation marker to the west side of the building (see

Figure 3.76).

Now that the elevation marker is out of the corridor, it’s time to make a new
one. To do so, make sure you’re in the Level 1 floor plan, and follow these steps:

1. On the View tab, click the Elevation button, as shown in Figure 3.77.

2. In the Type Selector, make sure Exterior Elevation is current.
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FIGURE 3.77:

The Elevation button on the View tab




Creating an Elevation

3. Move your cursor around the perimeter of the building. Notice that
the elevation marker follows the profile of the exterior walls. This is a
great thing!

v

W A R NI N G Whenyou're creating an elevation of a radial wall or nonlinear
item, be sure you know the exact angle at which you're placing the elevation marker.
When you're in the elevation view, you may get a false sense of the true dimensions based
on the view’s perspective. Draw a reference plane if you need to, and then place the eleva-
tion on that plane.

4. Pick a place for the elevation, as shown in Figure 3.78, and press Esc
to terminate the command.

- I

FIGURE 3.78: Theelevationisplaced. You can select the view arrow and move
the extents of the elevation into the building.

5. When the elevation is placed, select the triangle. You see the same
extents window that you saw in the previous section (see Figure 3.78).
This controls how deep into the model you’re viewing, and it also
shows you the length of the section. Because you placed this elevation
up against a wall, Revit stops the extents of the elevation at that wall.

6. Pick the top grip, and stretch the elevation past the wall, as shown in
Figure 3.78.

7. In the Project Browser under Elevations (Building Elevation) is a
new elevation. Right-click it, and rename it West Wing Southeast
Elevation.
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8. Open the elevation.
9. On the View Control bar, change the scale to 1/4” = 1'-0” (1:50 mm).

10. On the View Control bar, set the detail level to Fine. (You can also set
these in the Properties dialog at any time.)

11. Save the model.

You've added a new exterior elevation. You can add an interior elevation as
well. It’s just as easy and much more fun!

Interior Elevations

The difference between an exterior elevation and an interior elevation is the
same as the difference between a building section and a wall section. Both
interior and exterior elevations are executed the same way: by selecting the
View tab on the Design bar. The only difference is that you can make a choice
between the two in the Type Selector in the Options bar. To add an interior
elevation, perform these steps:

1. Go to the Level 1 floor plan.
2. On the View tab, click the Elevation button.

3. In the Type Selector, choose Elevation : Interior Elevation, and place
it in the area shown in Figure 3.79.
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FIGURE 3.79: Addinganinterior elevation and making the adjustments
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4. Hover your cursor in the corridor near a point shown in the middle

of Figure 3.79. Notice that when you move your cursor up, the arrow

flips up. When you move your pointer down, the arrow flips down.

5. Make sure the arrow in the elevation target is pointing up, and then
pick a point along the horizontal corridor, as shown at the right of
Figure 3.79, to place the elevation. Once it’s placed, press Esc to ter-
minate the command.

6. After you place the elevation, select the arrow. Notice that the extents

are outside the building. (This occurs in most cases. If it doesn’t,
you're good to go.) Select the elevation again and, on the left side,
pick the blue grip and drag the left extent to the point shown at the
left in Figure 3.79. Repeat the process for the right side as well.

7. In the Project Browser, there’s a new elevation under the Elevations
(Interior Elevation) category. Right-click the new elevation (Revit

will call it Elevation 1 —a or something similar), and call it East Wing

Corridor North Elevation.
8. Open the new view called East Wing Corridor North Elevation.

9. Notice that the crop region extends all the way up to the parapet.

Select the crop region, and drag the top down to Level 2, as shown in

Figure 3.80.
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FIGURE 3.80: Stretchingthe grip down to crop the view

N O T E Ifyou had floors already placed in the model, Revit would create the
interior elevation so that it extended only to this geometry. Because you don’t have
floors, Revit doesn’t know where to stop. If you happen to place an elevation without
floors and put them in later, Revit won’t make the adjustment. You'll have to adjust the
interior elevation manually for the new floors.

Let’s create some more elevations.

1. Go to Floor Plan Level 1. Zoom into the east wing entry area, as
shown in Figure 3.81.
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In the elevation’s view,
you can drag the crop
region down to show
only that floor. If you
would rather see all

of the floors, perhaps
you should use a
section rather than an
elevation.
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101

101

FIGURE 3.81: Addtheelevation marker as shown here, and then move it to a
new location.

2. On the View tab, click the Elevation button.

3. Place an elevation marker in an area similar to the one shown in
Figure 3.81, and then move it to the center of the lobby.

to wander all over the place. This is because the elevation is trying to locate the radial
geometry. The safest bet in this situation is to find a straight wall and aim the elevation
at that wall. In this case, you should aim the elevation at the bottom of the elevator shaft.
When the elevation marker is in place, you can then move it to where you need it to be.

@ T | P Notice that when you're trying to place the elevation in the entry area, it seems

4. With the elevation marker centered in the lobby, select the round
bubble. Four blue boxes appear, as shown in Figure 3.82. These boxes
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let you turn on multiple views. Turn on all four views, as shown in
Figure 3.82.
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FIGURE 3.82: Turnonall fourviews in the lobby.

With the four elevations turned on, you have some naming to do! Up to this
point, you have been going to the Project Browser to rename the elevations. Let’s
explore another way to rename an elevation and to view its properties as well.

Elevation Properties

With each view comes a new set of properties. For example, when you made the
perspective view of the corridor, you set Visual Style to Shaded, and you turned
on shadows. Normally, in an interior elevation, you don’t want to do this. Revit
allows you to have separate view properties on a view-by-view basis.
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By changing the value
in the Properties dia-
log, you are, in effect,
changing the name in
the Project Browser.
Again, change some-
thing in one place, and
it changes in another.

Chapter 3 « Creating Views

To access the View Properties dialog, follow these steps:

1.

¥ ® N S N K

On the interior elevation with the four arrows, select only the arrow
facing up (north).

The Properties dialog provides a wealth of information about that
view. You have a multitude of options as well. Find the View Name
option under the Identity Data heading, and change it to East Wing
Entry North Elevation, as shown in Figure 3.83.

Properties =
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Referencina De.. %

Properties help Apply

FIGURE 3.83: Changingthe View Name setting to East Wing Entry North
Elevation

. Select the East Wing Entry North Elevation again. Notice that the

view’s extents are stretching past the entry atrium. Pick the blue
grips at the end of the elevations, and bring them into the atrium
area, as shown in Figure 3.84. Also, drag the view limit up to show
the radial exterior wall (see Figure 3.84).

Click the elevation arrow facing left (west).

Change View Name to East Wing Entry West Elevation.
Click the arrow facing down (south).

Change View Name to East Wing Entry South Elevation.
Click the arrow facing right (east).

Change View Name to East Wing Entry East Elevation.
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10. Select each elevation, and adjust the view’s extents as you did for the
north elevation.

11. Save the model.

FIGURE 3.84: Makingthe adjustments to bring the view back into a
reasonable range

The actual view names appear in the plan. This is nice, but unfortunately it
leaves no room for anything else other than the view. Plus, no construction
documents have these names right in the plan (at least, none that I have ever
seen). You can turn off this feature.

Now that you can place and modify annotations, let’s delve into their physical

properties.

Annotation Properties

Annotations all have properties you can modify. To change the elevation symbol
properties, follow these steps:

1. On the Manage tab, click Settings > Additional Settings > Elevation
Tags.

2. At the top of the Type Properties dialog, you see Family: System
Family: Elevation Tag. Below that is Type. Change Type from 1/2”
(13 mm) Square to 1/2” (13 mm) Circle (see Figure 3.85).
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Type Properties (23]
Famiy: [System Famiy: Bevaton Tag -] Load..
Type: [z crge -] [ ouhcate.. |
—
Type Parameters
Parameter | Value J
e
ElevationMark ~ [Elevation Mark Body Circle: Detail N_|
< Preview | oK J[ cancd  |[ memy |

FIGURE 3.85: Modifying the properties for the elevation markers

3. In Type Parameters, under Graphics, change Elevation Mark to
Elevation Mark Body_Circle : Detail Number.

4. Click OK.
5. Save your work.

6. Zoom back in on the elevation markers. They should look like
Figure 3.86.

FIGURE 3.86: Therevised, less-obtrusive elevation markers

N O T E  It’s Revit time! No longer will you see “dumb” placeholder information in a
tag. When you create your construction documents and put these views on sheets, Revit will
automatically fill out tags with the correct information. To take it one step further, you can
tell Revit not to print these annotations if the views they represent aren’t on a sheet.
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The ability to add elevations is a must. As you can see, physically adding an
elevation is simple. It does, however, take practice to manipulate elevations to
look the way you want.

Are You Experienced?
Now you can...

v/ create levels and constrain walls to stretch or shrink if the level’s
elevation information changes in any way

v/ cut wall sections and building sections through the model

v/ create detail views, allowing you to add plan sections through a wall
or a building section

v/ create a callout view and control the crop region

v/ add a camera to the model, giving the user a nice perspective of a
certain area

v/ create interior and exterior elevations within the model



